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Chapter One I- Introduction

1 Introduction:

QElectroTech is used to draw electrical and / or electronic diagrams;

QElectroTech is not used to simulate the operation of diagrams;

QElectroTech is for those who wish to build an electrical file (images, papers,...)
QElectroTech is not for those who want to test the operation, study the characteristics of
circuits

or other studies;

This book is for those who wish to learn how to use QElectroTech to draw industrial
electrical diagrams.

1.1 Objectives:

This book aims to introduce you to QElectroTech software.

What I propose as methods in this book is drawn from my experience, and is not the only
way to go.

I have tried to present in this book the necessary functions to the realization of the standard
industrial electrical diagrams.

You have to be careful, to get the most out of this book follow exactly the steps described
to master my way of doing things and then you can explore the rest of QElectroTech's
features and build your own way of working.

1.2 Download & installation:
To install the software, here is the link to the QElectroTech download page:
https://qelectrotech.org/download.html

€ Y ros  oeiectictecs cog dommiced

Présentation Télécharger QElectroTech
News
Captures d'écran
: Windows GNU/Linux Mac OS X
Galerie
Téléchargement Version 0.5 (current stable)
Guide utilisateur 32bit systems

Youtube videos

Développement .
64bit systems
FOl'Um Windows Vista, 7.8 8.1, 10 / installer

Wiki Version 0.51 (development)

Select your operating system to start the download.
At the end of the download start the execution and follow the installation steps.



( g Installation de QElectroTech 0.60+svn3255 | = | |

PElectroTech sl
i 0.60+svnb255

Vous étes sur le point d'installer QElectraTech 0.60+4svn5255
sur votre ordinateur,

Avant de démarrer l'installation, il est recommandé de fermer
toutes les autres applications. Cela permettra la mise & jour
de certains fichiers systéme sans redémarrer votre
ordinateur.

Cliquez sur Suivant pour continuer,

LS

L | | ™
1%, Installation de QElectroTech 0.60+svn5255 ElEiEA
Licence utilizateur
Veuillez examiner les termes de |a licence avant dinstaller
QElectroTech 0.60+svn5255,
Appuyez sur Page Suivante pour lire le reste de |a licence utilisateur,
L
GMU GEMERAL PUBLIC LICEMSE |_|
Version 2, June 1991 S
Copyright (C) 1989, 1991 Free Software Foundation, Inc.
51 Franklin Street, Fifth Floor, Boston, MA 02110-1301, USA
Everyone is permitted to copy and distribute verbatim copies
of this license document, but changing it is not allowed.
Preamble
-

Si vous acceptez les conditions de |a licence utilisateur, diquez sur J'accepte pour continuer.
Vous devez accepter la licence utilisateur afin dinstaller QElectroTech 0.60+svn5255,

QElectroTech-0L60+5vn5255-1

LS

of the user license(J’accepte).

.Choose next (Suivant).

Read and accept the terms
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@ Installation de QElectroTech 0.60+svn5255

Chuoisissez les composants de QElectraTech 0.60+svn5255 que
vous souhaitez installer.

Cochez les composants que vous désirez installer et décochez ceux que vous ne désirez pas
installer. Cliquez sur Suivant pour continuer,

Sélectionnez les composants

e Main Program
ainstaller :

Eléments
Langues
Cartouches
i..[¥] Exemples

Description
Espace requis : 95.0Ma Passez e curseur de vaokre souris sur un composant pour

en voir la-descripkion,

QElectroTech-0L60+5vn5255-1

<irecaint K ot

LS

are selected and click on next (Suivant).

«Check if all program components

'& Installation de QElectroTech 0.60+svn3235

|'1

Chuoisiszez le dossier dans lequel installer QElectroTech
0.6045vn5255,

Cedi installera QElectroTech 0.60+4+5vn5255 dans le dossier suivant. Pour installer dans un
autre dossier, diguez sur Parcourir et choisissez un autre dossier. Cliquez sur Installer pour
démarrer linstallation,

Dossier dinstallation

E‘nﬁr_oﬁram Fi|EShEEE¥r(.JTEd'I1I,

Parcourir...

Espace requis : 95.0Mo
Espace disponible : 52, 1Go

QElectroTech-0,60+5vn5255-1

< Précédent || Annuler

IClick to Install (Installer).



'& Installation de QElectroTech 0.60+svn5255 | = | H : J

AISEMige [cepf Installation en cours
' i) Veuillez patienter pendant que QElectroTech 0.604+svn5255 est
en train d'étre installé,

Extraction : termostatica3_4.elmt

QElectroTech-0,60+5vn5255- 1

[ TE Il 1
| = Préecedent || Suivant> | | Annuler

J4Wait for the installation to be

LS

complete.
F :
ﬁ Installation de QElectroTech 0.60+svn5255 | = | =! | J

| Fin de I'installation de QElectroTech
{pELectroTech Tt i

.
QElectroTech 0.60+5vn5255 a &té installé sur votre
ordinateur,

Cliquez sur Fermer pour quitter le programme d'installation.

[7] cocher pour lancer QElectraTech

gelectrotech.org

Annuler

< Précedent 1'
13

L Click on close (Fermer).
And here you have just completed the installation, and you need to set the language.

.,




Chapter two II- Presentation of QElectroTech

2 Presentation of QElectroTech:

QElectroTech: Designed for electricians, and is free software for drawing electrical
diagrams with the ability to create projects, elements and collections in several categories;
it also helps in the creation of electronic diagrams.

Version: QElectroTech is currently available in version 0.6 and is under license GNU /
GPL. Operating System: QElectroTech is currently available for Windows and Linux.
Simulation: For the moment QElectroTech does not allow to carry out simulations.
Level of difficulty: QElectroTech is simple and easy to use software with simple drag and
drop

you can do most manipulations to make the drawings and with these options of page jump
you can easily navigate and follow the course of the circuit.

Main advantage: QElectroTech is much easier than other paid software like. Main
disadvantage: for those who want to make simulation of their electrical design and
drawings for the moment they cannot do it with QElectroTech.

2.1 Launching and creating your first folio:

To launch QElectroTech: go to the start menus% Programsi&QFElectroTech and click on

QElectroTech:
L T -~

e (fen Pt Mhagn Confopuston  Fontioe  Aaie

SlaH | - r ® 1 -

[ —

To change the language: go to Settingsi% Configure QElectroTech
El QElectroTech

File Edit Project Displainduws Help

E-TI D E;.Ll 'J:J L:I:El Display

Projects )

Filter | == Configure QElectroTec

#~! And chose your language:

| a A NrT el Lo 0o

10



—rﬂ Configure QElectroTech

General

Mew project

~ —-

Printing

General

Appearance
|Ise system colors %

Projects

(") Use windows {applied to the upcoming launch of QElectroTech)
@ Use tabs (applied to the upcoming launch of QElectroTech)

[7] Allow unzoom beyond the folio

[7] use gestures touchpad

Do not store the labels of items in the copy paste

|Use labels of folio instead of their ID

Export terminals in the parts list

Elements management

Highlight freshly integrated elements in the panel

Element may indude information about its authors, license, or other useful information.
Spedify the default value of this textfield for new elements below;

nch QElectroTech.

|| cancel

)

Create a new drawing project: To create and open a new drawing project:

click on the following icon
or go to the "File" menu and click on "New"
or just click on Ctrl + N:

11



k] QElectroTech
[ File | Edit Project Display Settir

T
1T [ B .
P2 | B Quit e 2.3 New Folio: To

have an empty folio with the following default template create a new Project.

ki QeiectroTech e fo(Te
File Edit Project Display Settings Windows Help

POEBRES 5S¢ XD S s Flofle sy @~E M= 000

Prajects & %

| B Untitied project 3 || Collections 5 x
- -

i | z | 3 4 s & 7 e | s [ 10 | n 2 | 13 W | 15 s | 13

a P Untitled project §
] 141 - Untitled folio f 5 Untitled project
[=] Embedded title blocks b R B e et BBt o et B P B AT e s | |« B QET Collection

# B QETtitle blocks friaiieitie bt Sl PR e Sipesivionne TR T ; gﬂm’i‘:
=] “44_ 1" template e b A e el Fe T el R o o b e S el s o D T R T Pl T B il | Legic
] “default® template e P Hydraulic
(] "DIN_AA" template : § fe ¥ : - g ! ! : ! i ! ! B Pneumatic
|| "double-loga” template Pk B Energy
] "IS07200_A4_V1" template I e P i 2 et PR e | £ User Collection
[ "single-logo” template

£ Usertitle blocks

jsen Pt
o Felr 11 |
S

O = |
2.4 Display the Resource Elements Panel:

Go to the "Settingsi&Display "and check that" Projects "and "Collections" are checked.
ESEﬁings] Windows Help

; o . N~ o -, o
Bl i S=bbEnmikats e obssns e s Lo 1]

o F Projects
u

= Confi ElectroT -
. el i | Unda . If this is not the case,
click on "Projects" and "Collections" in the "Settings 3 Display" to view the resources

items:

O

2d project
Collections

12



[l QelectroTech =anon
File  Edit Prn'E:i DﬂE'I}' Sett‘krE Windows H@

EEEEEE TG
Projects

o

4 1 Untitled project
= 171 - Untitled folio
[ Embedded title blocks
a B QET title blocks
[—] "Ad_1" template
[ “default’ template
|| "DIN_A4" template
[—] "double-logo” template

= 2 Untitled project
FaOI, - L + B QET Collection
display i ) B Electric
and T TR | B Logic
move i p . B Hydraulic

Pneumatic

Energy
£ User Collection

[ "1507200_44 V1" template ' LE e . i
[ "single-logo” template iy szl il e sty o

Z Usertitle blocks

Project
elements

H e i i clements  onioe

E'Hr: ’ = ’ ’ ’ - Fie: ] utesm
B Fola: 11 |

| ] '

New drawing project Main Window
2.5 Add a new:
To add a new folio, click on the icon

, in the right.
B QElectroTech - el 50
Fide Edit Project Display Settings: Windows Help

PRABRERS 5 ¢ XD R0 p———
— L click here to add

Filte - | .
- STl Tl oo | anew folio

BT Untitled project
a [ QET Collection
o B3 Electric

r B Logic
+ B Hydraulic

™ Preumatic

[ 171 - Untitled folic

| Embedded title blocks
& [l QET title blocks

] A4 1" template

== "default” template

| "DIN_A4" template

| "double-logo” template FEr D N el Gl T e SRS e 10 P P B I e ‘_'3'5""9)'
ISOT200_M V1" bemplate s ey i iRy e e e T i 8 User Collection

—| "single-logo” template ¢ S i i . . : : 4 ! ! 4 : e

User title blocks

Do

« I I I v

ﬁn ' S L e |

A new folio is added to your project.

13



--------------------------- To navigate between folios click on the title of the folio

i B
I;lfJ}z— gz -
EEEEEEEEEEEEEEEEEEEEE2.6Save:Tosaveyourproject:

Click on Ctrl + S
Or go to the "File" menu and click on "Save"
File | Edit F'rcr_|ect Dlspl_g,r Settir

|__'® Latest files L4
P New Ctrl+N ¢

e Ctrl+F4
i Ctrl+P

Ctrl+Q

Choose the location where
you want to keep the
project, name it (for
example: tutol1) and click

Save.

Mom du fichier: tutol]

Type : | Projet QElectroTech (".qet)

v Cacher les dossiers ! Enregistrer .

2.7 Save-as:

To save your project under another name go to the "File"
menu and click "Save As"

14



| File | Edit Project Display Setti

[@ Latest files
BT Mew
B Open

'l Saveas
i

L] Export
= Print

B Quit

b
Ctrl+M
Ctrl+O
Ctrl+5

Ctrl+F4

Ctrl+5Shift+X
Ctrl+P

Ctrl+Q)

Choose the location where you want to save the project, name it
(for example: backup tuto1) and click Save.

backup tutcl

[Project QElectraTech (*.qet)

Click on Ctrl + O

or on the icon

2.8 Open:
To open an existing project:

or go to the "File" menu & "open"

you want and click Open

File | Edit Project Display Setti

[@ Latest files

Save as

Close

Export
Print

Quit

Ctrl+F4

Ctrl+Shift+X
Ctrl+P

Ctrl+Q

Then open the project location, select the project

Now, to continue, please open the project "tuto1" that you have saved before.
2.9 Change the title of the folio:
How to obtain the following result (a folio with the title "Power circuit Diagram"):

15



Q 1/2 - Power circuit Diagram Q 22 - I:'

Power crout Degram
D=te: Folio: 1/2

We will modify the title of the folio and name it "Power circuit Diagram", for that:
click on the following icon

........ in Diagram bar
B @ @ m e
t [modified Folio properties |

or go to the menu "Edit" -> "Edit properties of the
folio"
or just click on Ctrl + L

16



File fEdEt Project Display Settings Windows Hel|

E 23 Undo modify the title block Ctri+Z
Projed & Redo Ctrl+Y
Filter
< A an | Cut Ctrl+X
[ Copy Ctri+C
El  Paste Crel+V
a5 Select All Ctrl+A
“« K 2% Select none
I7  Invert selection Ctri+I
Delete Del
B Rotate Space
% Choose texts orientation Ctrl+5Space
[@  Find in the panel
g
.—E]_. H @  Edit the selected object Ctrl+E
|.-| =  Reset conductors Ctrl+ K
s
.l (& Folio prog]ties @
222

R The following menu is displayed:

r
gl Folio properties

=

Dimensions of folio Type Appearance
Columns: 17 5| x60pixel |5 Display headers 7] Multiine
Rows: 8 |2 xaopixel |2 [V] Display headers i =

Text Formula :

Text:

¥

< ]

Auto Numbering

) [=]

Title block informati
e blockintormations [ show one text per folio potential.

Template: ’uDefauIt template "] Function :

Voltage / Protocol :
Title: Angle of conductor labels:
Author: Vertical
Date: @ Mo date
) 4 g LY
(©) Fixed date: | 25/10/2018 < /[ 4 \
I % 270,00° [
File: \ J
Lt »
Falia: %id [ Yetotal T
Plant:
[ single line
Lacation
Rev index | =% ground
Page Mum: ’Create an auto folio numbering * ] _Y & \ .
\ \ \ ® neutral
| phase
Main Custom

Horizontal
—r—
J n,
+ Eﬂd;ﬂ%l 0,00° | :
e ”

| PEM

[ ok || cancel

Type 'Power circuit Diagram' in the 'Title' input box to change it

17




Titles | |a

s b To validate the change click OK, if you do not want to
change the properties of the folio click on Cancel.

2.10 Properties of the folio:

To modify the Properties of the folio:

click on the following icon

Or go to the "Edit" Editing Folio Properties menu

or just click on Ctrl + L

And the following menu appears:

QecroTech
chier [-Em Projet Aﬁlchage Conflguratlon Fenétres £
g[ " Annuler Ctri+Z :
aeldél ™ Refaire Ctrl+Y
r B 2L | Couper Ctrl+X m
rer Copier Ctri+C ]:
= AL Coller Ctrl+V fol
B
B =/ Tout sélectionner Ctri+A
4 B Désélectionner tout
. Inverser |a sélection Ctrl+I
g
g & Supprimer Suppr
B Pivoter Espace
5 Orienter les textes Ctrl+Espace
E Retrouver dans le panel
= A Editer |'objet sélectionné Ctri+E
T £ e ——— |
[ Ctrl+L : .D.

>
B F_II. | Enlever une colonne . Ctﬂ l
|

18



4 Folio properties

Dimensions of folio
Columns: 17 12 x60pixel

Rows: 8 % x80pixel

= Display headers
= Display headers

Type Appearance

[¥] Multiline
Text size 7
Text Formula :

Text:

|

0 [

Auto Numbering

=
-/ [=]

Title block informations

Template: [uDef—duIt template "]

[7] Show one text per folio potential,

Function :

Voltage / Protocol
Title: Power dircuit Dlagram| P
Author: [ Available as variable SGtitle for title blocks herﬁczﬂ Horizontal
Date: |§I Mo date . P
x 1.3 g L [ h Y
@ Fixed date: | 28/10/2018 € [ 4 / _
L TR ¢ w000 [+ Eﬂm p,00° |2
File: \
Lt w | L]
Folio: ioid atotal St il
Flant:
[ single line
Location
Rev index ~ ground
Page Mum: [Create an auto folio numbering V] ‘K & \ ) .
\ \ \ ® neutral PEM
| %, phase | ) 1
Main Custom

You can then change the number of columns and rows in the folio.
the default numbers are: 17 columns and 8 rows

you can also change the date and choose a fixed date

Dimensions of folio

Columns: 1 x60pixel | Display headers . P
Rows: 3 51 xB0pixel | Display headers i
" and / or change the size of the text
and its orientation
Angle of conductor labels:
Vertical Horizontal
L g LN s N
+ % & 70,000 2 L Eler.tug 0,000 =
‘..__ . A '.h » f
g5 i ~ For now, type your name in the Author
entry
Authar:
box

2.11 The Collection & Search:

19



The most interesting part of the software is Collection; you will find readily available
elements, imported elements and the elements created by the user.

Collections g X

Search

4 M Untitled project
M Imported elements

4 B3 QET Collection

+ B9 Electric

> B Logic

+ B9 Hydraulic

> B Pneumatic

+ P4 Energy

& User Collection

Here's how to search for an element: type the name of the element in the search box:
What I liked the most about QElectrotech is the ability to edit the elements in the way that
suited

me or according to the needs of customers.

Collections g X

Search

Example:
Search for Motor: type motor and press enter, and scroll to find the Motor element

20



Collections

mu:ub:r|

g X
o

4 Ll QET Collection
4 M Electric
4 M All-pole
4 ™ Fuses and protective gears

4 ™ Magneto-thermal dircuit break. ..
[ ..I ..'.,I...'.II : . .
Motor circuit breaker

il “
B

1

T=TrT=h

Motor drcuit breaker ...

4 ™ Relays, contactors and contacts
4 M Contacts

@--? Contact Motorized MC

I
@-\ Contact Motorized MO

[gm, | »

-

Collections

th
X

mnb:r|

o
« | T scroll up =
4 ™ Electric

4 M All-pole

| |

4 [ Fuses and protective gears

4 ™ Magneto-thermal circuit break. ..

o .';,! N

-,.. Maotor circuit breaker

Pt
k E‘-_:"Ei Motor drouit breaker ...
4 ™ Relays, contactors and contacts
4 M Contacts

@'-? Contact Motorized MC
I

2.12 Insert and link automatically elements:
The insertion is done by a simple "drag & drop and place" on the drawing work space.

Y
scroll down >

So if you want to insert an element in the drawing work space, look for this element in the
Collections, click and hold the left button on the chosen element, drag it on the drawing
work space, release the left button, move the element to the desired location and click on
the left mouse button a second time to validate it, repeat the last step as many times as
necessary; to finish click on the Escape button (ESC) on your keyboard.

)
|

|

3 E

2.12.1 Example:

We will insert in the following example a three-pole source + neutral (L1, L2, L3 and N).

Open the project "tuto1" as described in "2.8.0pen".
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File Edit Project Display Settings Windows Help

EoEBRa e xpm s Fofleotisg a~E@ER 004

Progacts 8 x _:_ﬁ_ Project tutn1 Bi‘ Collactions (s
i [ 1/2 - Power circuit Diagram | Hap- o
# B2 Untitled project [modified] 1 | 32 | 3 | 4« | £ J 7 | & s | 10 TR 0 | s 5 | % || [ = =
=] 172 - Power Scheme o= i T : T 4= Three-pole source
[=] 272 - Untitled folio . ﬁ s =
‘BEEETE":::E::i:'ﬂEh'““ __i_j o ThrapilreR s BEEN
A4 1 template . b A
| "default” template ' =3 _ Thres-pole source =
] "DIN_A4" template H 3 g Wapd e
| "double-logo” template 1 =
] "1S07200_A4 V1" template ;%Tt— pole source + neutral
_| “single-loge” template [ B
& Usertitle blocks L] 7..:l:1nra\source
& see rize - i & — Phase source
m roff N ,
e[ | ]1:Click and hold the left button on the Three- | L, eTRNTCST
H | | pole source + neutral element. | 5 x
| | ]2:Drag it on the schema and release the button | | cwe E =
1| 13:Move the element to the desired location and | E“I“’“ ] =)
] 5 . . e ™)
-] click on the left mouse button a second time to ——————
|| ] validate. B
e, X s
ey P e — e e .
S Fower cecut Degram }7&b P

‘ ~Mr. ADILRAJI

For this go to "Collections" 2% "Electric" &% "Allpole" & "Network supplies
Scroll down and look for "Three-pole source + neutral”

B | Collections g X
B
| 16 |

Search

»

........ 4 [ Untitled project

oy > P Imported elements
FircEn bl 4 L QET Collection

........ 4 P Electric

m

........ 4 M All-pole

........ > P Folio referencing

........ 4 | Metwork supplies
8]

i | Ground

= Search
s | = 2

_ Three-pole source + neutral

w

.-
N —% Meutral source

Click and hold the left mouse button;
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4 ™ Untitled project {modified]
[ 1/2 - Power Scheme
[=d 2/2 - Untitled folio
[} Embedded title blocks
« [l QET title blocks
[ "Ad_1" template
[ “default” template
|| "DIN_A4" template
|- “double-loge” template
[] "1507200_A4 V1" template
[ “single-laga" template
2 Usertitle blocks

Untitied project [modified]

0 |/colectors.
[ S r—

[ & [ = T & T & [ a0 [ a0 | 12 | 335 | & [ 5 | & |

Fi:
Folo: /2

.\ |

e e @ Ele e o=lale

Drag it into the power circuit diagrams:

1vi

= — Three-pole source

-

‘E Three-pole source = PE N

_ Thiee-pole source = PEN

[ — |

T —— . : ‘
mrmEBPR@/sclxpm o [Fo@ecnn @@ Ee -

wi Help

| Projects. #x | A Project tutol ax
Fiter [ 1/2 - Power circuit Diagram ‘ Har-
4 [ Untitled project [modified)

] 1/2 - Power Scheme

] 2/2 - Untitled folio

| Embedded title blocks
4 [ QET title blocks

Ll "Ad_1" template

(=] “default’ template

L] "DIN_A4" template

1 "double-logo” template

! "1507200_A4_V1" template

] "single-logo” template

& Usertitle blocks
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Release the left button and move the item to the desired location

@ — Three-pole source
o

= Three-pole source + PE+N

. Three-pole source + PEN H
. Three-pole source + neutral ‘

n — Neutral source

+ — Phase source

- — Datrbubon point TN-C >T_

T -

r. ADILRAJI

£

= Configure




U QiectroTech =
File Ecit Project Display Settings Windows Help
poBRpR2 sc xbalos Foflo s =@ = 00
Projects #x| & Project tutol [ ] ‘ Collections & x
e = /2 - Power crauit Diagram | [l 2/2- =
4 P Untitled project [modified] i [ 2 [ 3 [ « [ 5 [ & [ 7 | 8 [ & [0 [ i [ & [ B [ = [ 5 | 1 |
(=] 1/2 - Power Scheme e Ly L : > h 3 ' 2 4 — Three-pale source
=] 2/2 - Untitled folio sl i ==

[-] Embedded title blocks -

: * | Three-pole source = neutral

a Bl QET title blacks
[ "A4 1" template
[ "default” template
| "DIN_AA" template
] "double-loge” template
[=] "1S07200_A4 V1" template
|| "single-loge” template
2 Usertitle blocks

. = Three-pole source + PE+N

~ Three-pole source « PEN

__ Thee-pole saurce + neutral

» — MNeutral source

« — Phase source

- — Distribubon point THC 5T
-

Fiel
Folo: 12

m ]

V|

Vi

RAJI

B = |

r. ADIL

Sy 2

And c_:lick the left mouse button to validate the location.

T QfiectraTech

File Edit Project Display Settings Windows Help

prEBBRE e/ xba 0 [Fo e

s B+ERE - 0o&

Powesr circut Dagram

Folio

Projects x| M Project tuto1 B |/ Collections LR
ites [ 1/2 - Power diraust Disaram | [ 2/2- o —
4 B Untitled project [madified] 1 | 2 | 3 | & | s | &6 | 7 | & [ s [ [ i | 2 | = | w | 15 | s ]|
=] 1/2 - Power Scheme e SR CE e hEL @ — Three-pole source
5] 2/2 - Untitled folio alh oIl e - S
| Embedded title blocks - B e Al =1
4 B QET title blocks = d = : 7= Hhtee-poiesourca s PE+N
[ "A4 1" template b el nel i i
é default” template Tt | ade et AR _ _ Three-pole source - PEN
- "DIN_A4" template e P A -— g
] "double-loga" template : : :
— : c 12 i) o=
| "IS07200_A4 V1" template : s Sols B Rl _ Three-pole source + neutral
[] "single-fogo" template | = A 2 : =
& Uset title blocks 4\ b A H = — Neutral source
| hgy by D0}
i T e L e e © — Phase source
e julig iyl SR + —. Distribustion point TN-C 5T..
E/lin i ety b ok ot Pt ol e .08 -
[ ik ieatii Auto Numbenng Select & x
. S Element | -,
futher:
Dwar
P

Fist
Feler 1/2

[\ |

m

1vi

N |

For more explanation we will in the rest of this chapter realize a direct online (DL)

starter circuit diagram of induction motor.
So for the power diagram we will insert and link the following elements:

Real name of the component

Name of the component to enter in the search box Filter

Collection containing the component

L

Induction motor

E‘Iv;i Three-phase engine

Three-phase engine
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T:....i " Contact power contacter

Power contactor Contact power contactor

T 4
| | \]\g){\F Circuit-breaker
Circuit breaker k

-

BN R
Thermal relay " ""™™'"** Thermal relay

4 B QET Collection
4 ™ Electric
4 ™ All-pole
4 ™ Consumers and actuators
4 M Engines

@ Engine

One-phase engine

» K@ Three-phase engine
contactor (%)

4 BJ QET Collection
4 ™ Electric
4 M All-pole
4 [ Relays, contactors and contacts
4 | Contacts with cross referencing
4 M Power

d
\ Contact power contactor

Circuit-breaker

»

m

gt g
-.:-{ ) Contact power contactor

'R
'il 15 ’1 I'I Contact power contactor

? Contact power contactor (...
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4 B4 QET Collection
4 B Electric
4 ™ All-pole
4 ™ Fuses and protective gears
4 P Circuit-breakers
L

I

Circuit-breaker

Circuit-breaker

o T

3
'I.j :
7

Circuit-breaker

;
;

el

=

Circuit-breaker

=
'\"J'_F

4 Bl QET Collection
4 M Electric
4 M All-pole
4 [ Fuses and protective gears
> P Magneto-thermal circuit breaker GV
4 1 Thermal relays

i

H]F Thermal relay

Thermal relay

Thermal relay

A
M

E————

Thermal relay

o

/In order to realize a direct online (DOL)

starter circuit diagram follow exactly the steps described below:

2.12.2 Inserting the motor:

1: Click and hold the left mouse button
2: Drag it on the diagram

3: Let go of the left button (Release),
4: Move it to the desired location

5: Click on the left mouse button to validate the location.
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[=] 172 - Power cireuit Diagram RS I | x e o . s = QET Collection il
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L "default’ template SR b A bR I BRI Dbt PR RN AS SRR gy : @ Engie
2] "DINAY” template I SEORE H ] eaBeoabi s spa bl i ! Dl i
= |
[=] "double-logo” template | o . ) : ] T
] "I507200_A V1" template c i e Biniiin e Briiiiiisiise st = (M) One-phase engine

|-} "single-logo” template i

2 Usertitle blocks 1 i e . . . 7 1= okl
1 R (B | HIE e R T ) R 4 i A A BT B R Tl A B S gk ol o ) 2 | Three-phace engine
e 4 i i L Lobiaiiiiii N I bt i
! §c:

T
-ag it on the diagram #)  Threephaseengine 1

Ly e B

Releascthebutton

A

Click and hold the

il 5 left mouse button =
i ! ! |ty 8 x
_.,5:,-3 s TSl Bl S Ml nabe Bas e S r sihslannni n 2o || EECSR | =

i PR, A A S BB Gl b b et s Bl RSO H H st b I AT B pre e et Dl (7= [ 7
| [ Click to Validatﬂ' : : Brahed o = —
[~-A_the location ' ' ' o [ Scofgre

Power croult Dagras

Mr.ADIL RAJI

2.12.3 Insertion of the thermal relay and automatic connections with the motor:

It is possible to connect the elements between them automatically (this connection is made
on two axes: horizontal and vertical).

To show you how to do this we will insert a thermal relay and position it in such a way that
the software automatically connects it with the motor.

1: Click on the Thermal relay and hold down the left mouse button

2: Drag the Thermal relay on the diagram

3: Let go of the left button.

4: Move the thermal relay until the software marks a connection between the relay and the

motor.
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File Edit Project Display Setings Windows Help

poEERE Sc xpans oo oo 8@ o2 00k
Projects x| = N " Projecttuiol [rodfied] S B3 | Collectons g X
[Fitee | = 1y2 -power arst Dagram | [ 272 B e
4 P Project tutol [modified] . - - bt =
i TS g
[ 2/2 - Untitled folic Alme | S i : : Piiiiiy Ll 12 b i <@ an“"f“i“" |
[] Embedded title blocks e B e e ~ Bvneemg 1
4+ [ QET tite blocks | =ity : P R e e h H s : S L « P Allp Chck a.ﬂd
[ : B4 e : s 3 el e a P
L "Ad 1" template , + | e : 3 2 T * it i
e . REdEa et 2 = e 4 hold down
1 » |
|l "DIN_A4" template R the leﬁ
[] "double-loge™ template !
[ "I507200_Ad_V1™ template Bizea S SRR o T { mouse button
Il "single-logo” template ' E
2 Usertite blocks |1 1] Let go of the left ;
D 5 i)
' button and move the =
e 1 e iy
£ ! Z thermal relay |l ‘H ;“ B rva retay wide
| 5 S ™ Residual Circuit Breskers
™ Relays, contacters and contacts
F faarih iRl 9 Sensors and instruments
|| & P Sinalenals =
5 : wé\ ; Auito Numbering Select 5 x
| | ®ATS ] software marks a connection Condicte [
W i | between the relay and the motor s —_—

. . Mr.ADIL RAJI

5: Click on the left mouse button to validate the location:
Finish inserting the thermal relay click on the Escape button (ESC) on your keyboard.

F— — —————— - —_—— - - - = -

The escapes button (ESC)
2.12.4 Insert contact power contactor:
We will now insert power contacts and link it automatically by the same method.

1: Click on the Contact power contactor and hold down the left mouse button.

2: Drag the Contact power contactor on the diagram.

3: Let go of the left button and move the Contact power contactor until the software marks
a connection between the contact and the relay.
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File Edit Project Display Settings Windows Help

BERREER& D«
Projects & X

x B alo s Mol

g @@ D@ 0o

e
4 ™ Project tutal [modified]
[=] 1/2 - Power circuit Diagram
[=] 272 - Untitled folio
[=] Embedded title blocks
« Bl QET title blocks
] "A4.1" template
[ "default” template
[] "DIN_A4" template
[ "double-logo" template
[ "I507200_A V1" template
Ll “single-lego” template
& User title blocks

contact and the
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[=] Project tuto! [modified] O | colectons LS
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e 1 2 1= 1 s 1 s T el 2 [ 81 s Tl wlewlls x| gercss -
|52 ; R . : i ; : .
Erase CaT R 4 B all-pole
e — 1 i G # [ Relays, contactors and contacts
X Let go of‘the LTI 4 [ Contacts with cross referencing
""" left button and | gigiat i i [
_. Siaiadl Said move the \;ﬁk Contact power contactor 7
{1 ] Contact power - iy . —
m e contactofuntij ol Drag s Canitct pawer (41 contipowercontactor |
------ i it contactor on the diagram & |
the software = ~ ctpi_Jr contactor
marks a T ETEEE il
connection \I res e contactor
between the fe s @

conmneniany - Click on the Contact
| power contactor and hold
down the left mouse button

 Mr.ADIL RAJI
4: the left mouse button to validate the location:
Click on Escape button (ESC) on the keyboard to finish.

F

2.12.5 Inserting a Circuit-breaker

We will now insert a Circuit-breaker and automatically link it by the same method.
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- f
T e o 8 ) B A b e e I A A R 1
i \? Circuit-breaker

Let go of the left button and
move the Circuit-breaker until the
software marks a connection
between the Circuit-breaker and
the contact, and click to finish

o
\;' "\; Circuit-breaker
L - 7 ,IIL
Drag the Circuit- 1 Wi e
breaker on the diagram. i B e

Click on the

Powar cizul Diagram

=

Circuit-breaker
_____ i —m=1and hold down
5 i [the left mouse
==et fbutton.
::be 12 ]-
Mr.ADIL RAJI

To end this exercise click on "Save"

to save the modifications made to the project.

2.13 Manually linking the elements:

To learn how to manually link two items in a circuit diagram
perform the steps in the following example to get this result:
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""" To achieve that result we will start by manually linking N

with the Circuit-breaker:

1. Move the mouse cursor until you select the end of the N source terminal, click and hold

the left mouse button to maintain the selection

2. Move the cursor to the end of the 15 contact of the Circuit-breaker

A
1

AT 8
......... B
ali—
u ......
',{.'_;%:::::
DR I b -

il e Sk ;

A T
::::f:%f;ﬂ?fffff b ey
Rl Sne B e
'ZZZ\".’"T"'_’ EENge
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0 e e S SR
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_ﬁ_ _: _'F’_ﬁ_ _:_ _: _: 3. Release the left mouse button to validate
L1_1—| ..........
hﬁgz;::::::::::
u ...........
e e e e

R ) VT
5t & \_\F¥\;‘F ﬁ
Al PP We will repeat the same steps for L1, L2 and L3.

So to manually link L3 with the circuit-breaker please follow these steps:

1. Move the cursor until you select the end of the L3 terminal, Click and hold the left
mouse button to maintain the selection

et D REIIR S TS S WA
po g g g e T
° fffffffffhjiﬁszff f f'f\%f_gi_f* "‘ﬁffffff
e LS
i¥¥¥ﬂnfr:V: L T

Release the left mouse button to validate
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steps:

1. Move the mouse cursor until you select the end of the L2 terminal, Click and hold the
left mouse button to maintain the selection

2. Move the cursor to the end of the 3" contact of the Circuit-breaker
3. Release the left mouse button to validate

e

manually link L1 to the Circuit- breaker by performing the followmg steps to complete the
link between the source and the circuit-breaker:

1. Move the mouse cursor until you select the end of
the L1 terminal, Click and hold the left mouse button to
maintain the selection

\'\\'\ Fo P58 ==hsaEs e \ " 2. Move the cursor to the end of the last contact of
the Circuit-breaker
3. Release the mouse button to validate
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cd.d. 4.8 .. d 4. d.% 214 Modify Attributes of elements:

2.14.1 Changing the name of a wire (a link): 2.14.1.1 Change the name of the wire
between L1 and the Circuit-breaker:

1. Move the cursor until you select the connecting wire between 1.1 and the Circuit-
breaker

2. double click with the left mouse button

- - double click

3. Wait for the conductor propertles editor to appear.

4. Clear the contents of the text box "Text" and type 'L1'
5. Validate the change by clicking OK
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.4 Edit conductor properties

Type | Appearance

Multiline

Text size : 7

[

Text Formula : |
Text:
Function :

Voltage [ Protocol :

Angle of conductor labels:

Vertical

270,000 [

LY " 4 m

[ single line

TA N
L\

= ground

® neutral PEM

% phase

—

.,".“g---..".. ’ g
¢ 4 SHE

Horizontal
.
ElE.Cr.[lQ D_.-UU o ! :

.

Apply properties to all conductars of this potential

Text:

Text: Ly

0 v

name of the wire between L2 and the Circuit-breaker:
1. Move the cursor until you select the connecting
wire between L2 and the Circuit-breaker

3 Wait for the conductor property editor to appear.

4 Clear the contents of the text box "Text" and type 'L2'

5. Validate the change by clicking OK
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ki Edit conductor properties !
Type Appearance

Multiline

Text size : 7 .

[l |

Text Formula : |
Text: e 0
Function :

Voltage / Protocol
Angle of conductor labels:

Vertical Horizontal
e i - -
I.-' ﬂ I". .": _" :
+ 4 27m,00° |4 + M o.o0e |2
'm v h | !'I

T '-..‘_-

[ single line

M =< ground

FAN
\ \ \ [¥] ® neutral . PEN

. phase 1

[¥] apply properties to all conductors of this potential

[ Ok J I Cancel

Text: _‘ a |_7_|
Function : ﬁ '||

o

K|
)
Eﬂj :T_
Text: I L2| a |_7_| ‘
: 2.14.1.3Change

the name of the wire between L3 and the Circuit-breaker:

1. Move the cursor until you select the connecting wire between L3 and the Circuitbreaker

2. double click with the left mouse button |- - - -
conductor property editor to appear.

3. Wait for the
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4. Delete the contents of the "Text" text box and type 'L3'
5 Vahdate the change by chcklng OK

u 'Edit cundljctm ’prmpeﬂm .- '

Type Appearance

Multiline fi

1iH |

"I

Text size : I-"

Text Formula ; |
Text:
Function :

‘oltage [ Protocol
Angle of conductor labels:

Vertical Horizontal

n

A —

» g Y » :

Fi \ Jf \

+ ¢ 20,000 2] 4  Hedug oo

" - 4 u .
~—a— —
[ single line
R [¥] = ground
\ \ \ | ® neutral ] PEN
% phase (1

[¥] apply properties to all conductors of this potential

Function :

K
LAy
—
Text: L3 ) ‘ 2.14.1.4Change

the name of the wire between N and the Circuit-breaker:

1. Move the cursor until you select the wire
between N and the Circuit-breaker
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3. Wait for the conductor property editor to appear.

4. Clear the contents of the "Text" text box and type 'N'

5. Validate the change by clicking OK

ed Edit conductor pmpert;:vls

Type Appearance

Multiling

Text size : I-"

FI|

Text Formula ; |
Text:
Function :

Voltaf= [ Protocol :

Vertical

% =

[ single line

i
B

| ® neutral

Angle of conductor labels:

.

-

270,00° & +

\n

—h—

| =% ground

| PEN

% phase

EJe.ctuq 0,000 2]

Horizontal

-

»

Apply properties to all conductaors of this potential

Text: ‘ : 4]
e
Function : Vot

Text: I M|

2.14.2 Changing



the Circuit-breaker name:
1. Move the cursor until you select the Circuit-breaker

e

. .\I'.”. AR
\f %\f ... 3. Wait for the element properties editor to appear.
4. click on Information

Inﬁ:rﬁn |_[

5. disable the Label formula and clear the contents of the Label box and type

F1
6. Validate the change by clicking Apply
5] 'Qﬂedru'fech .
| L
7 Cross-reference {master) | Information General a
Available elements
Thumbr:a'rl Label folio Title of folio  Position
172 Power circu...
4 | 1 |
Elements related [ it ] | b
Thumbr;ail Label folio Title of folio  Position
4 | 1 |
Reset Cancel ] | Apply I
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L4 QElectroTech 7

Cross-reference {master) Infﬂrw | General
Rt

Label formula Y
Foprefix 0
Label

F Q ¥

Annotation

Designation

Manufacturer

m

Maer_JfachJ_rgr reﬁarem_:\e
Builiary block 1

Buxiliary block 2

Machine manufacturer reference

Location

Label formula Label formula

.‘!-‘npreﬁx.

abel Label

2 oM~ Fl [

2.14.3 Changing the name of the contactor:
1. Move the cursor until you select

r:ﬁ _next to the Contact power contactor by clicking with the left mouse button
2. double click with the left mouse button to edit the contents of this box

3. Wait for the cursor to start flashing in this box.

4. Clear the contents with the 'Delete’ button on the keyboard and type 'KM1'

5. Validate the change by clicking on the drawing sheet away from this box
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2.14.4 Change the name of the Thermal Relay:
1. Move the cursor until you select the Thermal Relay
2. double-click with the left mouse button

3. Wait for the element properties editor to appear.
4. click on Information

S R
infojgion | TLTTDTUR p 0 AT
& I --E?-"-} PEce MA
J(_'ill'- Régizge &
= el s
k_/l‘“_ U S P —
ko QElectroTech

Crossreference {master) | Information General

Available elements

Thumbn'ail Label folio Title of folio  Position
172 Power circu...

Elements related [ # ] | b4

Thumbn'ail Label folio Title of folio  Position

o) [
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L. QElectroTech

Cross-reference (master) Inwm General
Label formula |G_| -
Zoprefix & 0
Label

F Q [V

Annumﬁ?n

P

Manufaclq.lrer

m

Manufacturer reference

Wuiliary block 1

Wuiliary block 2

Machine manufacturer reference

Location »
71l
(ot ] (ool

clear the contents of the Label box and type F2
5. Validate the change by clicking Apply

5. disable the Label formula and

abel formula -
Sprefix ﬁ
abel |
: o iy
abel
i k'l 0
nnotation IQ-"I abel
= @ TFZI

name of the Engine:

1. Move the cursor until you select the Engine

2. Double click with the left mouse button.

3. Wait for the Engine Properties Editor to appear.
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ki QFlectroTech

Information General

Label formula

Label
M

Annotation

Designation
Rt
Manufacturer reference
Wuiliary block 1
Wudliary block 2

Machine manufacturer reference

nration

m

Reset

Cancel

J

Appi?]

box and type 'M1'

4. Clear the content

5. Validate the change by clicking Apply

abel
M ‘ o
notation |
©

2.15 The tips: 2.15.1 Zoom:
To zoom in: go to Display menu & Zoom In

Or use the keys: "Ctrl" with "+"

abel

s of the "Label" text

M2 T

To zoom out: go to Display menus% Zoom Out
Or use the keys: « Ctrl » with « - »

[E Display projects

*  Select

Mowve

Display the grid

Background

[@ Zoom content

O Fit in view

l, Resetzoom

[Dispiaj,r Settings  Windows Help

Ctrl++

Ctrl+8
Ctrl+9
Ctrl+0

!Di‘sp!ag,r] Settings  Windows Help

Display projects 4

Select

MMowve

Display the grid

Background color white / gray

Foom Out

Ctrl+9
Ctrl+0

Fit in view

Reset zoom
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2.15.2 View mode:



After zooming in, probably, you would need to move the drawing sheet to see the rest and
that's where you'll need the Move Mode; To activate it go to the menu Displays&Move

Display | Settings Windows Help

[E Display projects r

Display the grid

NIEE

Background celor white / gray
&% Zoomln Ctrl++
a9l Zoom Out Ctrl+-
[@ Zoom content Ctrl+8
G5 Fit in view Ctrl+9
O Resetzoom Ctrl+0

Click on the left mouse button

&
- Hold the button and move the mouse to move the
sheet
1
=
ECE ] DTS (e

==
L
L

L u L
M
G

Plage _Af_A
Réglage _&

I — —

Wi

)

- Down
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[y
Lt
Ll

0 Y
JE = g
N L
Ti T2 T3
O
E
71 11 F
F I [ ) peee wa
Réglags _A
L ' ' 2.15.3 Folio a

Folio:
Now to see how to link the diagrams of the two sheets we will add a control diagram to the
power diagram already realized in the example of section 1.12 and link them by the "folio"
jumps.

Example:“folio” to“folio™:

el i l ﬁ l | J( o
| \ PER R
.
T > 2A2
- > 2-A2
44 g4 g+
\\F\ -— SE B BA R :Tohavethesameresultasin

go to QET Collection N Electric & All-pole &% Folio referencing
Select : Going arrow
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drag / drop
4 Ll QET Collection
4 M Electric
4 M All-pole
[ _EI Folio referencing
a L1 QET Collection
4 ™ Electric
a M All-pole
4 | Folio referencing

&= Coming arrow

™ Progect tuto ! [modfied]
=] 12 - Power vt Diagram | 1372 -

A 1:2
L3
| pas
o
3
=
B _ ] [
| .:r: b SRS SIS i
{6a)
C b ; =
il i I
5 <i, iﬂii

m

B | Colections X
B!
4 9 Untitled project o
B Imperted elements
+ Bl QET Collection
4 3 Electric
4 M All-pole
P Fabo referencing o
&= Coming arow
i -
& %&ng armow
B Netw o s
onnvections =
P9 Cables and wiring
B9 Terminals and terminal strips
B Connectors and plugs
21 Fuses and protective gears
P Relays, contactors and contacts
P9 Transformers and power supplies
&| Comverters and irmoesterns
Sutn Numbering Select P x
Conducion "'!
Serent |
Faio |

+- Comfigre

~ Mr.ADIL RAJI

Move the cursor to place the selected item between the breaker and the contactor, on

the right

Click to confirm location
Move the cursor another time
Click to confirm location
Click on esc button

Move the cursor until you select the end of the first "going arrow" element
click and hold the left mouse button to maintain the selection
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Lt
Ll

T - - - - - - Move the cursor to the right end
of the circuit-breaker...

Release the left mouse button to validate

/

Move the mouse cursor until you select the end of the second "going arrow" element

click and hold the left mouse button to maintain the selection
Move the cursor to the left end of the circuit-breaker
Release the left mouse button to validate

TG W 7
AV R
o

—

e/

[
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- Now we will add the "Coming
arrow" and link elements in the second sheet of the drawing.

Click on the second drawing sheet that we created before.

go to QET Collection & Electric & All-pole &% Folio referencing

| =] 1/2 - Power circuiit Diagram | %;

A ‘ S B o
Select : Coming arrow

drag / drop

Move the cursor to place the selected item
Click to confirm location

Move the cursor another time

Click to confirm location

Click on esc button

4 L) QET Collection

4 ™ Electric

a M All-pole

+ | Folio referencing

4 B3 QET Collection
4 ™M Electric
4 M All-pole
4 ™ Folio referencing

* = Coming arrow

Select the one Coming arrow |
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.
11 a Py Untitled project

=

B Impoted elements
- 4 Bl QET Callection
a 5 Electnc
4 B Allpole
# ™ Fobo referencing
ing asmow

L= Goinglll ow

P Metwork supplies
B Connections

r h Cables and wiring
] ; P Terminals and terminal snps
B Connectors and plugs
B Fuses and protective gears
B Redays, contactors and contacts
B Transformers and power supplies
P Converters and inverters
Auto Humbering Select
Conducior
= 3 Bement
Folo

"~ Mr.ADIL RAJI

1/2 - Power dircuit Diagram | = 2

]l' B:-_ ...... I ' I
At S asbe e
.'II ! r
_::::::::a%:::::: J .
e g ft
__________ \o/ @ 2 ¥

Wait for the Properties Editor to appear.

Right click
Click on “Show item”

"""""""" Double click with

QElectrotech will show the folio of the selected line and highlight the arrow.
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Folio referencing

Search

General

=
M wire

Function

Voltage / Protoco Label folio
172

172

Folio referencing General
Search
N® wire Function Voltage / Protoco Label folio
- 172
B % 12
4 1 I
[ concel ] [_awoy ]
M* wire . Function

Voltage / Protoco Label folio

152
[ 142
Link the itermn
_SF??%‘
Show = ent
lid
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18 oy, 3

“Right click again on the selected line

Click on “Link the item”
The color of the selected line will change to green

Click on Apply to validate the cross reference between the arrow of this diagram
with the other present in the "power
diagram"in “folio1” located in “C4”

Right click on the second “coming arrow” and click on Edit the element
Right click on the remaining line

And click on “Show item”

L4 QElectroTech 7
’ r
Folio referendng | General
Searc ]
= I
M= wire Function Voltage / Protoco Label folio
- 1/2 |
£ 1
Fp 1 3
Reset Cancel I I Apply |
N= wire Function Voltage / Protoco Label folio
B 1/2
) Link t%‘em
Show ite &

Show slave,  ment
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Folio referencing General
Search L
N® wire Function Voltage / Protoco Label folio
- 1/2
[ 1/2
S el o Bon Dol Din
- E_f ._'._':_'.:;._"‘i .................
heeel o
ey Copy
... ® Resetconductors
coo. .| T Delete
H e Ii Rotate
SR R # Choose texts orientation
oo 1B Findin the panel
e &  Edit the element

Reset conductors

Delete
Rotate

Choose texts orientation

Find in the panel
Edi&l«emerﬁ

Voltage / Protoco Label folio

Folio referencing General

Search i

N® wire Function Voltage / Protoco Label folio

& 1/2

1| m | b —
[ cancel J[ aopy |

Link the item —_—

ﬁw item
lave element
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QElectrotech will show the folio of the selected line and highlight the arrow.

Right click again on the selected line
Click on “Link the item”
The color of the selected line will change to green

Click on Apply to validate the cross reference between the arrow of this diagram
with the other present in the "power
diagram"in “folio1” located in “C4”

Click on the first drawing sheet "Power diagram". to go back to the first diagram

You notice that a text is automatically added next to the arrows.
This text designates the location of the extension of these two.
The first part designate the folio number 2 Folio 2

The second part designate the location A2 Column: 2

Row: A
1 . é é s L
t D> 2-A2-
T B2 o
Folio referencing General Folio referencing | General
e Search
-- S i . ; .
M s Eiinciicn Voltage / Pro M= wire Function ‘u‘ultagv.j:irutucu_!ﬁt_tel folio
_ % = %‘nktheitem
@ g
L Sho, slave element
Folio referencing ! General
_ . | ‘
Search
N® wire Function Voltage / Protoco Label folio i
i Cancel I [ ) ]
i 142 :
R W

=] 1/2 - Power drcuit Diagram | =

¥ [ 2 | 3 Nm
ST el i QIIE-PDWEﬁuitDiagram | S2pe-
Al ity e
TR Te
..... SR —
s BT D pa Rl o ol
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To understand the utility of cross reference between the arrows double click on the text

Then QElectrotech will show the folio and the location designated by the text.

D

..................................... Now we will
change the nomination of these two wires

Go to foliol and double click on the first wire and wait until the dialog
"Edit conductor properties" appears

Type in the text box the title of the wire "L1"

Validate the change by clicking OK
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Text: L1 [ BRI

\c4 Edit conductor properties @

Type | Appearance

[] Multiline

Al

Text size : 7

Text Formula ;

<

Text: L1 [x )

Ti
L

Function :

Yoltage [ Protocol

Angle of conductor labels:

Vertical Horizontal
o —
= ] [} n
ok
4 o 270,00° 2] ¢  EHedig ;00 [
| » n v
. B "
[7] single line
% ground
S E
) II“'. )
ﬁ"-. ﬁ"-. l'"-. ® neutral PEN
R LR LR
% phase 1

[¥] apply properties to all conductors of this potential

RS [ cone

i
i
k.

y b

Double click on the second wire and wait until the dialog "Edit conductor

properties" appears
Type in the text box the title of the wire "N"
Validate the change by clicking OK

Move the cursor to select the second wire text designation ("N") Click and hold the left
mouse button

Move text
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Release the left mouse button

o B 58

Text: M a ]
\c4 Edit conductor properties
Type Appearance
Multiline
Text size ; 7 =
Text Formula
Text: M 0 ]
Function :
Voltage [ Protocol
Angle of conductor labels:
Vertical Harizontal
: - L .
- g = ™
¥} \
4 o 4 270,00° %] Electrigq ;o0 |2
L | L] "
S .

[ single line

Q =% ground

LA
\ \ \ ® neutral
%, phase 1 :

Apply properties to all conductars of this potential
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Move the cursor to select the first wire text designation ("L1") Click and hold the left
mouse button

Move text

Release the left mouse button

And here we come to make a connection between two drawing sheets of an electric
diagram by the elements "Going arrow" and "Coming arrow" this will allow us,
subsequently, to navigate easily between the different sheets of the diagram.

The text in front of the arrow indicates the location of the extension in this case we have
"2-A2" which means the location "A2" in the sheet 2 (Folio2), knowing that the location
"A2" means the cross between line "A" and column "2".

To see more clearly and understand these connections follow the steps below:

Double click on the text in front of the arrow
QElectroTech displays the element linked to the chosen reference

1 2
e 1ol
—1> 2-A2 & e O S e sl
T 1-G4 - B~
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Chapter three III- Finalize the diagram

3 Finalize the diagram:

3.1 Insert an image (your LOGO):

It is possible with QElectroTech to insert images into the sheets of the diagram; thanks to
this option you can insert the "Logo" of your company....

Here's how to insert an image:

Click on the "image insertion" icon

Sélectionnez 1’emplacement de 1’image que vous voulez insérer.
Select image

Click Open

Move the image to the botom of the drawing and clikc

Double click on the inserted image to open the image property box if you need to change
its size

kl Select animage ..

] -

P
o 4[}!7 \ | k= *» Bibliothéques » Images »
m@ e I:' L) [.S | Add a picture | I\'“"JI\"-'J | ———
Kl Select animage fomen e

b

LOGD

File pame:  LOGO = |Image Files (*.png ".jpg "jpeg * -

| Opes |» Cancel
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# .
k1 QElectroTech m

Image size

[} 100% ]

[ Lok Position

Move the cursor to change the dimensions of the image...

Click Apply to validate the change
Move the image

To see more clearly zoom in and to get more precession click on Ctrl button on the
Keyboard while you move the image

L4 QElectroTech -2 =3 |
Image size
[ /% |2
i X [ Lok Position
4 QElectroTech .
Image size
81% |

[T Lodk Position IG].—i

I\.Iu.l

[ Reset ] [ Cancel ] [ Apply ]
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And here is final result:

=

| 1/2 - Power dircuit Diagram | ] 2f2-

1 | 2 T EE 5 7 & s | 1w | u | & | B ] » 15 1 17
H'_}——.—.—.—— """" e
R R B A B A A A A B A P A A T A T A

T R A A b A b A A b o At o b A A At A A A A A A A A b A A
Bl A R B R A A A A A A P A I A i
B

;llglg_., .........................................................................................
R e R
_b.z_‘qz .............................................................................
| Lt AT L L L b T e e e e e e e e
...... B R A A A A A A
D::::::‘r_jnl_l:'.'n_u:::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::
S Fouiniininininniniadnininininindninaninast it eletbelataed el it lebelebetaed el bttt ettt fateletel ettt e et ettt et el et et teteb e d
b IR i
G::::::.c.‘:'.:f::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::::
e B B O S R B
B
futhor: % Re:
Powercirut Degrem
Cete: Fobo: 1f2

3.2 Print:

You can print your drawings by following these steps:
Go to the "File" menu and click on

"Print"

Or use the keyboard shortcut "Ctrl + P"
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ki QElectroTech

Edit Project Display Setti

| [@ Latest files k)

[ BT Mew Ctri+M |

[ Open Ctrl+0 :

| |
Save Ctrl+5 |
EF Saveas |
PY Close Ctrl+F4 |

| L] Export Ctrl+Shift+X

; = Print Ctrl+P [
Bl Quit Ctrl+Q

Wait for the dialog box to open You can then choose physical or PDF file printing type
If you choose PDF file printing type You will need to choose the file location.

Click on browse

] 1, open the dialog box to select the path to the location of the PDF file
Click “OK” to validate the change

B QElectroTech: Print preview

Waite for the print preview And click on Print
™ Printing type choice @ B Printing type choice

What kind of printing do you wish? What kind of printing do you wish?

E] i@ Print to a physical printer E] i@ Print to a physical printer

Ej ) Print to a PDF file Ej ﬁrint to a POF file

jsers\ra'Desktoputol. pdf | i ers ‘j' Jesktopituto 1.pdf
-
[ Ok J I Cancel I [ Ok ] I Cancel
- — @y

sersira'Desktopituto 1. pdf i | """""" b
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Folos to print :

o % F Eaw ]

(] Powser arout Diagram
W] Lintitied folo

Reendering ophions

] Draw the border
|| Dras Ee e block
7] Keep conducinrs cokrs

Print pptiors.

7 Use the whole page

t | = ) 3 | e | s | 8 | 2|« § s | = st | |w)|e| s | w]o

IF this option & chedked, fhe paper margins are: ignoned and its whole surface is used fior the printing. This may not be supported by your printer.
1 Fit folo o page

1F this optian i chedked, the follo will be shrinked




Chapter four I'V- Conclusion

4 Conclusion

You can now draw diagrams and easily add images to them.
You can further explore QElectroTech to become familiar with it, and keep in mind that it

is really packed with features and is updated frequently.
I will add more tips in the next edition of this guide, thank you for reading this one
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